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RZ/N2H Group 
Encoder I/F A-format sample program 

Summary 
This document describes the RZ/N2H Encoder I/F A-format® sample program package. 

For A-format® Ver.2.0 communication protocol specifications and encoder specifications (RES-61QAP06), 
contact Nikon Corporation. 

Functionality Checked Device 
RZ/N2H Evaluation Board (RTK9RZN2Hxxxxxxxxx) 
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1. Package Contents 

This package contains the following contents. 

The RZ/N2H encoder interface supports up to 13 axes, but the sample program uses only 1 axis of them. If 

you use it with 2 axes or more simultaneously, modify the sample program to support required axes. 
This sample program operation was checked with one-to-one connection A-format Ver.2.0 encoder. 

Operation with bus connection encoder is not checked. Operation with A-format Ver.1.0 encoder is not 

supported. 
 

1.1 Software 
• Source Code 

No. Name Version number 
1 RZ/N2H A-format sample program (CR52 ver.*) 2.0 
2 RZ/N2H A-format sample program (CA55 ver.*) 2.0 

 
Note   This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version 

that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective 
version. 

 
 

1.2 Documents 
No. Document name Version  File name 

1 RZ/N2H Group Encoder I/F  
A-format sample program 
Release Note 

2.00 (j) r11an0917jj0200-rzn2h.pdf 
(e) r11an0917ej0200-rzn2h.pdf (this document) 

2 RZ/N2H Group A-format sample 
program Application Note 

2.00 (j) r11an0916jj0200-rzn2h-a-format.pdf 
(e) r11an0916ej0200-rzn2h-a-format.pdf 
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2. File Structure 

The file structure and contents of this package are detailed below. 
Top 
├─ r11an0917jj0200-rzn2h.pdf  
├─ r11an0917ej0200-rzn2h.pdf  
└─ workspace 
   ├─ Software 
   │  ├─ iccarm 
   │  │  ├─ RZ_N2H_CR52_a_as.zip  : RZ/N2H A-format sample program set 
   │  │  │       CR52 ver. (IAR)  
   │  │  └─ RZ_N2H_CA55_a_as.zip 
   │  │     ├─ RZ_N2H_CA55_0_a_as  : RZ/N2H A-format sample program set 
   │  │     │      CA55  ver. (IAR) 
   │  │     └─ RZ_N2H_CR52_0_primary : CPU CTRL register setting program (IAR) 
   │  └─ gcc 
   │     ├─ RZ_N2H_CR52_a_as.zip  : RZ/N2H A-format sample program set 
   │     │       CR52 ver. (e2 studio) 
   │     └─ RZ_N2H_CA55_a_as.zip 
   │        ├─ RZ_N2H_CA55_0_a_as  : RZ/N2H A-format sample program set 
   │        │      CA55 ver. (e2 studio) 
   │        └─ RZ_N2H_CR52_0_primary : CPU_CTRL register setting program (e2 studio) 
   └─ Documents 
      ├─ r11an0916jj0200-rzn2h-a-format.pdf  
      └─ r11an0916ej0200-rzn2h-a-format.pdf  

 
 
The file structure of the RZ_N2H_CR52_a_as.zip and RZ_N2H_CA55_0_a_as folder are shown below. 

Top folder 
├─ configuration.xml    : FSP Configuration data 
├─ ( Build Tool Dependent Environment File ) 
└─ src 
   ├─ hal_entry.c     : A-format sample program 
   ├─ a_as_main.c    : A-format sample program 
   ├─ siochar.c     : SCI_UART sample program 
   ├─ siorw.c     : SCI_UART sample program 
   ├─ sio_char.h     : SCI_UART sample program 
   └─ drv 
      └─ a_as 
         ├─ iodefine_a_as.h   : A_AS register definition file 
         ├─ r_a_as_rzt2.c   : A_AS driver file 
         ├─ r_a_as_rzt2_config.h  : A_AS driver file 
         ├─ r_a_as_rzt2_dat.h  : A_AS driver file 
         ├─ r_a_as_rzt2_if.h   : A_AS driver file 
         ├─ r_a_as_rzt2_private.h  : A_AS driver file 
         └─ a_format 
            ├─ r_a_format_rzt2.c  : A-format driver file 
            ├─ r_a_format_rzt2_config.h : A-format driver file 
            └─ r_a_format_rzt2_private.h : A-format driver file 
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The file structure of the RZ_N2H_CR52_0_primary folder is shown below. 
Top folder 
├─ configuration.xml    : FSP Configuration data 
├─ ( Build Tool Dependent Environment File ) 
└─ src 
   └─ hal_entry.c     : CA55 start-up program 
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3. About A-format Sample Program 

This section contains information necessary to use the complete set of A-format sample program. 
 

3.1 Software Information 
3.1.1 Base OS 

This sample program is OS-independent. 
 

3.1.2 Memory Size 
Memory size used by this sample program and A-format driver is shown in the following table. This table 

does not include the memory size used by Flexible Software Package or C language libraries of the 
compiler. 

 
(1) CR52 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

A-format driver Code 4.2 3.5 
Data (with initial value) 0.0 0.0 
Data (without initial value) 6.1 6.1 
Constant Data 0.2 0.2 

Sample program Code 4.2 4.8 
Data (with initial value) 0.1 0.0 
Data (without initial value) 0.8 0.8 
Constant Data 1.8 1.9 

 
 
(2) CA55 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

A-format driver Code 6.0 5.8 
Data (with initial value) 0.0 0.0 
Data (without initial value) 6.7 6.8 
Constant Data 0.3 0.3 

Sample program Code 6.5 8.5 
Data (with initial value) 0.2 0.0 
Data (without initial value) 0.8 0.9 
Constant Data 1.9 2.1 
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3.2 Hardware Information 
3.2.1 Device 

RZ/N2H 
 

3.2.2 Target Board 
(1) Board Name 

RZ/N2H Evaluation Board (RTK9RZN2Hxxxxxxxxx) 

 
(2) Setting of Target Board  

The target board configuration is as follows. Do not push SW4 while you are using channel AFMT14. 

DSW2-4: ON, DSW2-6: OFF 

DSW5-1: OFF, DSW5-2: OFF, DSW5-7: OFF, DSW5-8: OFF 

DSW7-3: OFF, DSW7-4: ON 

DSW12-5: ON, DSW12-6: OFF, DSW12-7: ON, DSW12-8: OFF 

DSW13-1: OFF, DSW13-2: ON, DSW13-3: OFF, DSW13-4: ON, DSW13-7: ON, DSW13-8: OFF 

DSW18-5: OFF, DSW18-6: ON 

DSW19-3: OFF, DSW19-4: ON 

DSW20-1: OFF, DSW20-3: OFF, DSW20-5: OFF 

DSW21-2: OFF, DSW21-3: ON, DSW21-4: OFF, DSW21-5: ON, DSW21-6: OFF 

DSW3-1: ON, DSW3-2: OFF, DSW3-3: ON, DSW3-6: OFF (Set xSPI1 boot mode) 

JP8: Short between 2-3 pins (Set VDD1833_2 to 3.3 V) 

JP9: Short between 2-3 pins (Set VDD1833_3 to 3.3 V) 

JP23: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V) 

 

(3) Used Pins of the Target Board 

 The correspondence between the pin used as the encoder I/F and the pin header of the target board is as 
follows. Channels AFMT8, AFMT12 and AFMT15 are not available. 

Channel Port Name Pin Header Input/Output Voltage 
Domain 

Description 

AFMT0 ENCIFDI00 (SDAT) CN44 #9 Input VDD33 Data input 
ENCIFDO00 (REQ) CN44 #7 Output VDD33 Data output 
ENCIFOE00 (D/R) CN44 #5 Output VDD33 Drive/receive control 

AFMT1 ENCIFDI01 (SDAT) CN44 #8 Input VDD33 Data input 
ENCIFDO01 (REQ) CN44 #6 Output VDD33 Data output 
ENCIFOE01 (D/R) CN44 #4 Output VDD1833_5 Drive/receive control 

AFMT2 ENCIFDI02 (SDAT) CN43 #23 Input VDD33 Data input 
ENCIFDO02 (REQ) CN43 #21 Output VDD33 Data output 
ENCIFOE02 (D/R) CN43 #27 Output VDD33 Drive/receive control 

AFMT3 ENCIFDI03 (SDAT) CN43 #24 Input VDD1833_6 Data input 
ENCIFDO03 (REQ) CN43 #22 Output VDD1833_6 Data output 
ENCIFOE03 (D/R) CN43 #18 Output VDD1833_6 Drive/receive control 

AFMT4 ENCIFDI04 (SDAT) CN44 #27 Input VDD33 Data input 
ENCIFDO04 (REQ) CN44 #25 Output VDD33 Data output 
ENCIFOE04 (D/R) CN44 #23 Output VDD33 Drive/receive control 
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Channel Port Name Pin Header Input/Output Voltage 
Domain 

Description 

AFMT5 ENCIFDI05 (SDAT) CN43 #14 Input VDD1833_6 Data input 
ENCIFDO05 (REQ) CN43 #12 Output VDD1833_6 Data output 
ENCIFOE05 (D/R) CN43 #10 Output VDD1833_6 Drive/receive control 

AFMT6 ENCIFDI06 (SDAT) CN42 #18 Input VDD1833_3 Data input 
ENCIFDO06 (REQ) CN42 #16 Output VDD1833_3 Data output 
ENCIFOE06 (D/R) CN42 #14 Output VDD1833_3 Drive/receive control 

AFMT7 ENCIFDI07 (SDAT) CN42 #36 Input VDD1833_3 Data input 
ENCIFDO07 (REQ) CN42 #34 Output VDD1833_3 Data output 
ENCIFOE07 (D/R) CN42 #24 Output VDD1833_3 Drive/receive control 

AFMT9 ENCIFDI09 (SDAT) CN51 #18 Input VDD1833_2 Data input 
ENCIFDO09 (REQ) CN51 #16 Output VDD1833_2 Data output 
ENCIFOE09 (D/R) CN51 #14 Output VDD1833_2 Drive/receive control 

AFMT10 ENCIFDI10 (SDAT) CN51 #27 Input VDD1833_2 Data input 
ENCIFDO10 (REQ) CN51 #25 Output VDD1833_2 Data output 
ENCIFOE10 (D/R) CN51 #23 Output VDD1833_2 Drive/receive control 

AFMT11 ENCIFDI11 (SDAT) CN51 #26 Input VDD1833_2 Data input 
ENCIFDO11 (REQ) CN51 #24 Output VDD1833_2 Data output 
ENCIFOE11 (D/R) CN51 #22 Output VDD1833_2 Drive/receive control 

AFMT13 ENCIFDI13 (SDAT) CN43 #32 Input VDD1833_6 Data input 
ENCIFDO13 (REQ) CN43 #30 Output VDD1833_6 Data output 
ENCIFOE13 (D/R) CN43 #28 Output VDD1833_6 Drive/receive control 

AFMT14 ENCIFDI14 (SDAT) CN42 #35 Input VDD33 Data input 
ENCIFDO14 (REQ) CN42 #33 Output VDD33 Data output 
ENCIFOE14 (D/R) CN42 #31 Output VDD33 Drive/receive control 
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3.3 Procedures on Development Environments: CR52 ver. 
3.3.1 Preparation before Executing the Sample Program 

This sample program communicates with a PC. The USB connection terminal on the target board is CN27. 
Select higher-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Order of transmission / reception LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.3.2 EWARM from IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for Arm (EWARM) 

  Version 9.60.2 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2024-10 

RENESAS Flexible Software Package (FSP) for RZ/N2 v2.1.0 

 
(2) Execution Environment ICE 

IAR I-jet 

 
(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_N2H_CR52_a_as.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_N2H_a_as.eww.  
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn, 
rzn_cfg, rzn_gen, script and .setting folders will be generated. 

 
 
7 When project generation is complete, close the Smart Configurator. 
8 Select [Rebuild ALL] from the [Project] menu of EWARM. 

The file Debug\Exe\RZ_N2H_a_as.out is generated. 
 

(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Project] menu -> [Download and Debug]. 
2 Select [Debug] menu -> [Execute]. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.8 console commands in the RZ/N2H Group A-format Sample Program Application Note.  
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3.3.3 e2 studio from RENESAS 
(1) Build Environment 

RENESAS e2 studio 2024-10 

  Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24 

RENESAS Flexible Software Package (FSP) for RZ/N2 v2.1.0 

 

(2) Execution Environment ICE 

SEGGER J-Link v7.98c 

 

(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_N2H_CR52_a_as.zip and copy the extracted source files to the desired location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu -> [Import] and select 

Existing project to workspace and click [Next].  
3 On the project import screen, select the folder where the sample program was expanded as the root 

directory. 
4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml in the Project Explorer pane of e2 studio to open it.  
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzn, rzn_cfg, rzn_gen, script, .settings folders are generated. 

 
 
7 Select [Project] menu -> [Build All] 

The Debug\RZ_N2H_a_as.elf file is generated.  
 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging]. 
Click [Debug] to start downloading to internal RAM.  

2 Click [Run] menu -> [Resume] to run the sample program.  
 
 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.8 console commands in the RZ/N2H Group A-format Sample Program Application Note.  
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3.4 Procedures on Development Environments: CA55 ver. 
3.4.1 Preparation before Executing the Sample Program 

This sample program communicates with a PC. The USB connection terminal on the target board is CN27. 
Select lower-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Order of transmission / reception LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.4.2 EWARM from IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for Arm (EWARM) 

  Version 9.60.2 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2024-10 

RENESAS Flexible Software Package (FSP) for RZ/N2 v2.1.0 

 

(2) Execution Environment ICE 

IAR I-jet 

 

(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_N2H_CA55_a_as.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_N2H_CR52_0_primary -> RZ_N2H_CR52_0_primary.eww.  
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn, 
rzn_cfg, rzn_gen, script and .setting folders will be generated. 

 
 
7 When project generation is complete, close the Smart Configurator. 
8 Select [Rebuild ALL] from the [Project] menu of EWARM.   

The file Debug\Exe\RZ_N2H_CR52_0_primary.sbd is generated. 
9 Select [File] menu -> [Open Workspace].  
10 Open the extracted source file RZ_N2H_CA55_0_a_as → RZ_N2H_CA55_0_a_as.eww. 

(RZ_N2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file. 
Please build the primary project in advance.) 

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. 
12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn, 

rzn_cfg, rzn_gen, script and .setting folders will be generated. 

 
 
13 When project generation is complete, close the Smart Configurator. 
14 Select [Rebuild ALL] from the [Project] menu of EWARM.   

The file Debug\Exe\ RZ_N2H_CA55_0_a_as.out is generated. 
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(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 In the workspace of RZ_N2H_CR52_0_primary, select [Project] menu -> [Download and Debug]. 
RZ_N2H_CA55_0_a_as project is launched. 

2 In the workspace of RZ_N2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up 
program is executed. 

3 In the workspace of RZ_N2H_CA55_0_a_as, select [Debug] menu -> [Execute]. Sample program is 
executed. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.8 console commands in the RZ/N2H Group A-format Sample Program Application Note.  

 
 
 

3.4.3 e2 studio from RENESAS 
(1) Build Environment 

RENESAS e2 studio 2024-10 

  Toolchain version: 

 GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_N2H_CR52_0_primary) 

 GCC ARM A-Profile (Aarch64 bare-metal) 10.3.1.20210621 (Used by RZ_N2H_CA55_0_a_as) 

RENESAS Flexible Software Package (FSP) for RZ/N2 v2.1.0 

 
(2) Execution Environment ICE 

SEGGER J-Link v7.98c 

 
(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_N2H_CA55_a_as.zip and copy the extracted source files to the desired location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu -> [Import] and select 

Existing project to workspace and click [Next].  
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3 On the project import screen, select the folder where the sample program was expanded as the root 
directory. 

4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml of the RZ_N2H_CR52_0_primary project in the Project Explorer 

pane of e2 studio to open it.  

 
 
6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  

The rzn, rzn_cfg, rzn_gen, script, .settings folders are generated in the RZ_N2H_CR52_0_primary 
project. 

 
 
7 Select RZ_N2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build 

Project]. 
The file Debug\RZ_N2H_CR52_0_primary.sbd is generated. 

8 Double-click the configuration.xml of the RZ_N2H_CA55_0_a_as project in the Project Explorer pane 
of e2 studio to open it. (RZ_N2H_CR52_0_primary.sbd of the primary project is referenced to open 
this configuration file. Please build the primary project in advance.) 
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9 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzn, rzn_cfg, rzn_gen, script, .settings folders are generated in the RZ_N2H_CA55_0_a_as 
project. 

 
 
10 Select [Project] menu -> [Build All] 

The Debug\RZ_N2H_CA55_0_a_as.elf file is generated.  
 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the 
RZ_N2H_CR52_0_primary project.  
Click [Debug] to start downloading to internal RAM.  

2 Click [Run] menu -> [Resume] to run the CA55 start-up program. 
3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the 

RZ_N2H_CA55_0_a_as project.  
4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed. 

 
 
5 If 'Proceed with launch' is displayed, select 'Yes'. 
6 Click [Debug] to start downloading to internal RAM. 
7 Click [Run] menu -> [Resume] to run the sample program. 
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(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.8 console commands in the RZ/N2H Group A-format Sample Program Application Note.  
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of 
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the 
use of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas 
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas 
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. 
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products 
outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you 
are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 
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